
KNIME Analytics Platform

Installation Guide
KNIME AG, Zurich, Switzerland

Version 5.2 (last updated on 2024-10-10)



Table of Contents

Installing KNIME Analytics Platform . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

Configuration settings and knime.ini file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2

Allocating memory in knime.ini file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3

Installing Extensions and Integrations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4

Updating KNIME Analytics Platform and Extensions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

Update Sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

Default Update Sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8

Adding External Update Sites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Adding Local Update Sites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

Working with the Nightly Builds . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11

Release notes and changelogs (KNIME Analytics Platform 5.2) . . . . . . . . . . . . . . . . . . . . . . . .  12

KNIME Analytics Platform 5.2.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

KNIME Analytics Platform 5.2.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

KNIME Analytics Platform 5.2.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

KNIME Analytics Platform 5.2.3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

KNIME Analytics Platform 5.2.4 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

KNIME Analytics Platform 5.2.5 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

KNIME Analytics Platform 5.2.6 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32



Installing KNIME Analytics Platform

1. Go to the download page on the KNIME.com website to start installing KNIME Analytics

Platform.

2. The download page shows three tabs which can be opened individually:

◦ Register for Help and Updates: here you can optionally provide some personal

information and sign up to our mailing list to receive the latest KNIME news

◦ Download KNIME: this is where you can download the software

◦ Getting Started: this tab gives you information and links about what you can do

after you have installed KNIME Analytics Platform

3. Now open the Download KNIME tab and click the installation option that fits your

operating system. KNIME Analytics Platform can be installed on Windows, Linux, or

macOS.

Notes on the different options for Windows:

◦ The Windows installer extracts the compressed installation folder, adds an icon to

your desktop, and suggests suitable memory settings.

◦ The self-extracting archive simply creates a folder containing the KNIME

installation files. You don’t need any software to manage archiving.

◦ The zip archive can be downloaded, saved, and extracted in your preferred

location on a system to which you have full access rights.

Figure 1. KNIME Analytics Platform available installers

KNIME Analytics Platform Installation Guide

© 2023 KNIME AG. All rights reserved. 1

https://www.knime.com/downloads


4. Read and accept the privacy policy and terms and conditions. Then click Download.

5. Once downloaded, proceed with installing KNIME Analytics Platform:

◦ Windows: Run the downloaded installer or self-extracting archive. If you have

chosen to download the zip archive instead, unpack it to a location of your choice.

Run knime.exe to start KNIME Analytics Platform.

◦ Linux: Extract the downloaded tarball to a location of your choice. Run the knime

executable to start KNIME Analytics Platform.

◦ Mac: Double click the downloaded dmg file and wait for the verification to finish.

Then move the KNIME icon to Applications. Double click the KNIME icon in the list

of applications to launch KNIME Analytics Platform.

The following operating systems versions are supported:

• Windows

◦ Windows 10, 11

◦ Windows Server - 2016, 2019, 2022,

• Ubuntu 20.04 LTS and 22.04 LTS and derivatives

• RHEL/CentOS/Rocky Linux 8, 9

• macOS (12 and above - macOS x86_64 Intel) and M1 (macOS arm64 - Apple silicon)

(only the last two major versions are supported)

◦ macOS 12: Monterey

◦ macOS 13: Ventura


Also check the KNIME Getting Started Guide and the KNIME Analytics Platform

User Guide.

Configuration settings and knime.ini file

When installing KNIME Analytics Platform, configuration settings are set to their defaults,

and they can later be changed in the knime.ini file. The configuration settings, i.e. options

used by the Java Virtual Machine when KNIME Analytics Platform is launched, range from

memory settings to system properties required by some extensions.

You can find knime.ini in the installation folder of KNIME Analytics Platform.
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

On MacOS: To locate knime.ini on MacOS, open Finder and navigate to your

installed Applications. Next, right click the KNIME application, select Show

Package Contents in the menu, and navigate to Contents → Eclipse.

The knime.ini file can be edited with any plaintext editor, such as Notepad (Windows),

TextEdit (MacOS) or gedit (Linux).

Allocating memory in knime.ini file

The entry -Xmx1024m in the knime.ini file specifies how much memory KNIME Analytics

Platform is allowed to use. The setting for this value will depend on how much memory is

available in your machine. KNIME recommends setting it to approximately one half of your

available memory, but you can modify the value based on your needs. For example, if your

computer has 16 GB of memory, you might set the entry to -Xmx8192m.
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Installing Extensions and Integrations

If you want to add capabilities to KNIME Analytics Platform, you can install extensions and

integrations. The available extensions range from free open source extensions and

integrations provided by KNIME to free extensions contributed by the community and

commercial extensions including novel technology nodes provided by our partners.

The KNIME extensions and integrations developed and maintained by KNIME contain deep

learning algorithms provided by Keras, high performance machine learning provided by H2O,

big data processing provided by Apache Spark, and scripting provided by Python and R, just

to mention a few.

Install extensions from:

• KNIME Hub:

◦ Search for the Extension or Integration you want to install in the search bar

◦ Click Extensions on the results page

◦ Click the extension you want to install, and from the extension page and drag and

drop the squared yellow icon, shown in Figure 2, to the KNIME Analytics Platform.

A window will open asking if you want to search and install the extension or

integration. Click Yes and follow the instructions.

Figure 2. Install the KNIME Integrated Deployment Extension from KNIME Hub

◦ Restart KNIME Analytics Platform.

• KNIME Analytics Platform:

◦ Go to the Menu in the top right corner of the KNIME Analytics Platform.

◦ Select Install Extensions. The dialog shown in Figure 3 opens.
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Figure 3. Installing Extensions and Integrations from KNIME Analytics Platform

◦ Select the extensions you want to install

◦ Click Next and follow the instructions

◦ Restart KNIME Analytics Platform.

The Install Extensions menu provides the extensions that are available via the update sites

you have enabled.



If you encounter issues during the installation of Python based extensions,

these might be related to challenges specific to this type of extensions. Find

here information about how to troubleshoot these issues.

To uninstall an extension, go to the Help menu in the top right corner of the user interface

and select the About KNIME Analytics Platform. In the window that opens click Installation

Details. A dialog shown in Figure 4 opens. Now, select the extension that you want to

uninstall, and click Uninstall….

KNIME Analytics Platform Installation Guide

© 2023 KNIME AG. All rights reserved. 5

https://docs.knime.com/2023-12/pure_python_node_extensions_guide/index.pdf#installation_troubleshooting


Figure 4. Uninstalling Extensions and Integrations
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Updating KNIME Analytics Platform and
Extensions

It is good to make sure that you always use the latest version of KNIME Analytics Platform

and its extensions.

To do so:

1. Go to the Menu in the top right corner of the KNIME Analytics Platform.

2. Select Check for updates. In the dialog that opens, select the available updates you

want to install and then click Next.

3. Proceed by following the instructions. KNIME Analytics Platform has to be restarted in

order to apply the updates.
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Update Sites

The Update Sites are where KNIME retrieves additional software in the form of extensions as

well as updates. To see or edit the available update sites, click Preferences in the top right

corner of the user interface. This opens the Preferences dialog. Select Install/Update →
Available Software Sites.

Default Update Sites

These four updates sites are provided by KNIME and are always available:

Figure 5. Available Update Sites

KNIME Analytics Platform 5.2 Update

Site: Provides all extensions and

integrations maintained by KNIME: R,

Python, H2O Machine Learning, Apache

Spark for big data, and many more.

Contains KNIME Labs Extensions, which

are extensions that are not yet part of the

set of stable KNIME extensions because

their functionality may not yet be

finalized.

Community Extensions (Experimental):

Provides additional extensions created by

the KNIME community.

KNIME Community Extensions (Trusted):

Provides trusted community extensions,

i.e. extensions created by the KNIME

community, which have been tested for

backward compatibility and compliance

with KNIME quality standards.

KNIME Partner Update Site 5.2: Provides

extensions created by KNIME partners.

KNIME Analytics Platform 5.2 Update Site and KNIME Community Extensions (Trusted) are
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enabled by default.

Adding External Update Sites

To install extensions that are not part of the above update sites, click Add to manually add

the relevant update site, inserting the Name and Location as shown in Figure 6.

Figure 6. Add Update Sites

After adding a new update site you will see it listed in the Available Software Sites. You must

now enable it by selecting it from the list.

Adding Local Update Sites

If your working environment has limited internet access or you receive an error message

“Proxy Authentication Required” when connecting to a remote update site (provided by a

URL), you can install extensions from a local zip file.
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1. Download KNIME update sites as zip files at the following links:

◦ KNIME Analytics Platform Update Site

◦ KNIME Community Extensions

◦ KNIME Partner Update Site 5.2

2. Save the zip file containing the extensions to your local system

3. Click Preferences in the top right corner of the user interface. This opens the

Preferences dialog. Select Install/Update → Available Software Sites and enter the path

to the zip file by clicking Add → Archive… as shown in Figure 7.

Figure 7. Adding Update Sites from Zip Archive


If the same extensions are provided by a URL, you will first have to disable

the update site by disabling it in the list.

4. Now click Apply and Close



If the same extensions are also provided by a remote update site, you will

first have to disable that update site by deselecting its entry in the

Available Software Sites dialog and confirming via Apply and Close.
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Working with the Nightly Builds

Once a night, a new version of KNIME Analytics Platform is created directly from our

development branch. The Nightly Build versions available here provide insight into what’s

coming up in the next regular release. However, for real work, always use a version of a

standard KNIME release. Also read the following disclaimer before proceeding:



Really, really, really important disclaimer

This is most definitely not production quality code. These nightly builds are

what we use internally to validate and test recent developments, so they are not

tested as thoroughly as standard KNIME releases. Furthermore new nodes or

functionality may change substantially (or disappear entirely) from one build to

the next. It’s even possible that workflows you edit or create with nightly builds

stop being readable by future (or past) versions…

These nightlies are a great way to get a sneak peek at what may be coming in

the next version of KNIME and provide feedback and suggestions. They are not

a particularly safe way to do real work.
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Release notes and changelogs (KNIME
Analytics Platform 5.2)

Release notes and detailed changelog for v5.2.x releases

KNIME Analytics Platform 5.2.0

Release date: December 06, 2023

Release notes

• As of KNIME AP 5.1 the “Modern UI” is the new default user interface to view and edit

workflows. With 5.2 all relevant functionality has been ported but few remaining

features will be added in future releases. This includes:

◦ A tree view for the node repository

◦ Keyboard navigation for the most prominent features to enhance accessibility via

hotkeys within the Modern UI

◦ More perspectives in addition to the Starter Perspective

◦ General improvements to the space explorer

• “KNIME Reporting” is moved out of KNIME Labs (the BIRT reporting remains available

via KNIME Classic UI)

◦ Unlike KNIME Analytics Platform 5.1 the Reporting extension now requires the

use of a special Report Template Creator node, defining page layout etc. Report

workflows created in 5.1 will issue a warning during loading, and the user needs

to insert the start node separately

• Node and Extension Deprecation

◦ (Outdated) Weka extensions marked legacy and removed from update site

category

◦ KNIME Jython Scripting (Legacy) removed from update site category (previously

in KNIME Labs but no longer actively developed)

◦ KNIME Rule Viewer (Labs) marked legacy and removed from update site category

◦ PDF/HTML Writer Extension marked legacy (use full reporting extension instead)

◦ KNIME Column Storage (based on Apache Parquet) marked legacy; superseded

by columnar table backend (Arrow backed)
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Changelog (KNIME Analytics Platform 5.2.0)

New nodes

• AP-21641: Report Page Break (enforced page break between two report fragments)

• AP-21536: Microsoft Authenticator (with web-based UI)

• AP-21527: Box Authenticator (with new credentials widget, deprecates existing Box

Authenticator)

• AP-21514: OpenAI DALL-E node

• AP-21302: Email Mover (Labs)

• AP-21301: Email Connector (Labs)

• AP-20945: String Cleaner

• AP-20938: Add Generic ECharts View node with modern script editor and AI integration

• AP-20905: GPT4All Chat Model Connector

• AP-20826: Report Loop End

• AP-20791: String Format Manager

• AP-20788: HF TGI Chat Model Connector

• AP-20748: Azure OpenAI nodes

• AP-20725: Google Authenticator (with WebUI)

• AP-20388: Secret Retriever

• AP-19576: Email Reader (Labs)

• UIEXT-1208: Image View node

Enhancements

• AP-20216: Install bundled Python environment into bundling/envs instead of the plugin

to reduce long path problems (kudos to @yupliu and @DerMaxdorfer for reporting 1

and 2)

• AP-20829: (Classic Perspective) Truncate overly long character strings when rendering

- prevents freezes with large documents (kudos to @mwiegand for reporting 1)

• AP-20960: Support proxy settings in Python based nodes (kudos to @Erich_Gstrein and

@DrorMirzayof for reporting 1 and 2)

• AP-21469: Google Analytics Connector node to add selection for parent account (kudos

to @denisfi for reporting 1)
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• NXT-162: Save workflow as (kudos to @rfeigel for reporting 1)

• NXT-2050: Rename edit node label context menu option (kudos to @HaveF for

reporting 1)

• UIEXT-389: Non-auto axis limits across all plots (kudos to @Ammar_Muhammad,

@iCFO and @rsherhod for reporting 1, 2 and 3)

• AP-21605: Support org.apache.cxf.transport.http.forceURLConnection system property

to avoid CXF thread exhaustion

• AP-21575: Add GPU support for GPT4All nodes

• AP-21557: KNIME Rule Viewer (Labs) marked legacy and removed from update site

category

• AP-21556: KNIME Jython Scripting (Legacy) removed from update site

• AP-21553: Modern Script Editor with AI integration for Python Script and Python View

node

• AP-21522: Allow to set API base in OpenAI Authenticator

• AP-21467: K-AI: Display Markdown

• AP-21466: Google Analytics Connector to provide port object output for modern viewer

• AP-21429: HF Hub Chat Model Connector

• AP-21415: Add CID to mail attachments in Send Email node

• AP-21402: Allow to install K-AI from sidebar

• AP-21400: Reporting extension moved out of KNIME Labs

• AP-21394: Revise K-AI UI/UX

• AP-21383: Improve positioning of added nodes

• AP-21336: Column alias in db metadata (e.g. for SAP HANA calculated views)

• AP-21310: Value Lookup: Replace Lookup Column (similar to Cell Replacer

(deprecated))

• AP-21280: Reporting: Use CEF for PDF generation by default, make Bundled Chromium

an optional dependency

• AP-21265: REST Client Nodes (e.g. WebPage Retriever) to be more robust when web

pages illegally claim that content is gzipp’ed (but really isn’t)

• AP-21235: Check configuration of deployment when version is changed

• AP-21212: Allow to configure flow variables from hover icon in Python node dialog

• AP-21087: KNIME Hub Connectivity: Split into stable (installed by default) and labs
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• AP-21061: Allow user to configure page breaks in Reporting nodes

• AP-21050: String Replacer (Dictionary) with new default with regard to iterative

application of replacement rules

• AP-21045: Treat temporary service failures more gracefully in Explorer

• AP-21041: Improve deletion of multiple jobs in KNIME Explorer

• AP-21026: Show progress indicator when fetching jobs from KNIME Hub

• AP-21019: Support pagination in AP Explorer

• AP-20983: Add option to clear input field before filling it in Text Sender

• AP-20979: Teradata support in DB Connector node

• AP-20965: Increase StringHistory limit in Date&Time to String and String to Date&Time

nodes

• AP-20946: Robustify server address input validation in `AdditionalInformationPanel`s

• AP-20917: Expose more parameters in GPT4All Connectors

• AP-20908: Support credential port object in Python nodes

• AP-20906: Support multi-line string input fields in Python nodes

• AP-20893: Snowflake driver updated to version 3.14.1

• AP-20870: Snowflake Connector with support for new Credentials port

• AP-20868: Support Azure OpenAI for ai-service in BHub

• AP-20861: Microsoft SQL Server Connector with support for new Credentials port

• AP-20850: Prompt K-AI to answer in the question language

• AP-20849: Give K-AI a memory

• AP-20824: Missing value handling in vector store creators

• AP-20823: Support metadata in Chroma vector stores

• AP-20821: Scripting Editor KNIME communication and state management

• AP-20809: Reference the content that is used to create response

• AP-20789: Wait Node: Progress Bar to show remaining time

• AP-20784: Call Workflow nodes: Allow for KNIME hub version selection

• AP-20780: Optional Report Configuration Input Port at Components (when reporting is

enabled)

• AP-20761: Allow resizing and collapsing of panels in script editor

• AP-20734: KNIME Column Storage (based on Apache Parquet) marked legacy;

superseded by columnar table backend (Arrow backed)
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• AP-20733: PDF/HTML Writer Extension marked legacy (use full reporting extension

instead)

• AP-20731: Weka 3.6 (and before) marked legacy; superseded by newer version -

extension is uncategorized

• AP-20714: Excel Reader supporting reading large files (300+ MB)

• AP-20653: Java Node API: Add Supplier API to NodeLogger

• AP-20605: SAP HANA support in DB Connector node

• AP-20551: Sorter implementation optimized - fewer comparisons in merge phase

(+improved progress)

• AP-20550: GroupBy & Pivot optimized: Speedup due to new sorting routing and fewer

data scans

• AP-20484: Workflow Summary Extractor node: Output empty instead of redacted string

for empty passwords

• AP-20436: AP-wide authenticated proxy support for REST requests

• AP-20404: Add Date & time parameter for Python node settings

• AP-19999: Improve CASE Switch Start node handling of invalid flow variable input

during configure

• AP-19913: Credentials Configuration: Support Credentials Flow Variables from outside

Component

• AP-19518: Support pretty names of SAP HANA calculated views

• AP-16729: Support writing of password protected Excel files (Excel Writer & Excel Cell

Updater)

• AP-12956: Type mapping for chemistry types (Sdf, Smiles, Mol, and PDB) - enables

direct reading and writing to databases

• BD-1209: (Big Data Extensions): Include Databricks JDBC driver version 2.6.34 in

Databricks feature

• NXT-2171: Delete underlying links inside workflow annotations without removing the

link text

• NXT-2169: Open Layout Editor from outside the component

• NXT-2153: Support y-position and height on metanode port bars

• NXT-2142: Display progress for Node Extension Cache construction on startup

• NXT-2133: Reload space via a button

• NXT-2129: URL in annotation box is not easily editable or deleted
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• NXT-2124: Duplicate space item

• NXT-2115: Move metanode bars

• NXT-2101: Opening, editing, saving shared components on a Hub

• NXT-2096: Display extension name and vendor in the node repository

• NXT-2089: Provide a submenu entry in Menu to open the KNIME log location in the file

explorer of the operating system

• NXT-2045: Bendpoint ui and ux improvements

• NXT-2022: Automatically check workflows with linked components for updates after

open a workflow or component

• NXT-2008: Edit and delete schedules via the kebap menu

• NXT-2001: Restructure Home / Info Panel into submenu items

• NXT-1964: Draw connections in front of nodes nodes

• NXT-1944: Add and remove bendpoints

• NXT-1938: Open local component project in a separate application tab

• NXT-1937: Link / unlink components

• NXT-1926: Collapse bottom panel

• NXT-1925: Switching workspace

• NXT-1923: Detach node monitor port view into a separate application window

• NXT-1918: Save as workflow or delete jobs in KNIME Server modal

• NXT-1916: Display jobs and schedules of KNIME Server workflows

• NXT-1915: Open swagger API / Open in WebPortal for KNIME Server space items

• NXT-1914: Execute and schedule KNIME Server workflow

• NXT-1913: Set KNIME Server permissions

• NXT-1912: Basic KNIME Server support for Modern UI

• NXT-1903: Add Open legacy port view button in node monitor

• NXT-1820: Group spaces by owner

• NXT-1735: Selection, annotation and pan mode for the workflow editor

• NXT-1730: Show complete progress message in tooltip while node is executing

• NXT-1643: Move space items from one hub space to another hub space on the same

hub

• NXT-1508: Enhance behaviour of opening workflows form an external space provider
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• NXT-1457: Display component metadata when selected

• NXT-1211: Enable selection functionality for detached table node monitor

• NXT-1083: Add and connect to selected node via a double click in the node repo

• NXT-1012: List based node repo view

• NXT-944: Edit component metadata

• NXT-191: Rendering and moving bend points for connections

• UIEXT-1358: Enable 2-factor authentication for credentials widget

• UIEXT-1329: Enable custom row heights in table view

• UIEXT-1310: Add execute shortcuts to new dialogs

• UIEXT-1216: Add ui to control flow variables

• UIEXT-979: Add possibility to show only selected rows in table view

• UIEXT-917: Fix scroll bar to right side of view port

• UIEXT-899: Enable color handling in existing column based views

• UIEXT-611: Bar Chart change default for positioning/coloring bars

• UIEXT-310: Remove padding and margins in data apps

Bug Fixes

• AP-19973: Update sites don’t work with Proxy requiring credentials (kudos to

@Nuke_Attokurov for reporting 1)

• AP-20588: Sorter node does not handle missing flow variable for alphaNumStringComp

(kudos to @richards99 for reporting 1)

• AP-20998: Component input / output nodes are classified as missing node, when it is

configured with a port object from an extension that is not installed (kudos to @takbb

for reporting 1)

• AP-21003: Vector store tool is not used correctly by agent (kudos to @lsandinop for

reporting 1)

• AP-21043: Google Analytics Connector node does not list all available properties

(kudos to @denisfi for reporting 1)

• AP-21398: Row Aggregator miscalculates weighted average (wrong formula) (kudos to

@Bytecrawler for reporting 1)

• NXT-1927: Execute button is above the table (kudos to @sw1336 for reporting 1)

• NXT-2026: Some 'Locales' prevent workflows from being displayed (kudos to @k1000

for reporting 1 and 2)
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• AP-21552: Classic UI: Component update status indicators not updated on error

• AP-21539: Metanode to Component conversion fails under special circumstances

• AP-21065: Adding file system input port removes outgoing connections to metanodes

• AP-21059: Decision Tree View (JavaScript): encoding issues on Windows

• AP-21046: AP: can’t delete multiple jobs in one go

• AP-20799: Shared Component in not-shared Component not updated

• AP-20727: Expanding a component can fail (when connections just go through)

• AP-21634: Node description of Call Workflow (Table Based) node wrongly lists report

generation

• AP-21619: Add pyarrow-hotfix to python-legacy environments

• AP-21587: Properly handle UNC path in Report PDF/HTML Writer node (on Windows)

• AP-21584: Access denied error when uninstalling python extension on windows

• AP-21583: Statistics calculation stores references to DataValues

• AP-21563: Vector store creators fail if empty document is provided

• AP-21560: Update pyarrow in knime-python-base=5.2 to 14.0.1 to prevent CVE-2023-

47248

• AP-21495: K-AI error is not reported in frontend

• AP-21494: Preference page does not support customization profiles on KNIME Hub

• AP-21472: Issue with prompts when loading KNIME

• AP-21446: Send to Tableau Server node opens up large amounts of ports and does not

close them on Windows Server

• AP-21417: BIRT Report not generated when using Call Workflow nodes with hub callee

• AP-21378: Table View (JavaScript) cannot display Local Date Time type data on

Japanese desktop

• AP-21375: GPT4All .gguf models do not work

• AP-21367: Table Cropper fails after Python nodes

• AP-21365: Space Connector should be disabled in remote workflow editor when KNIME

Hub Authenticator is attached

• AP-21352: Jobs disappear in explorer when workflow is deleted and workflow with

same name is uploaded

• AP-21322: Overwriting different types of Hub space items fail without any warning/error

messages in MUI
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• AP-21260: Report Writer PDF/HTML with CEF fails when used with relative-to workflow

KNIME URL

• AP-21252: xlink:href attributes in HTML coming from WebpageRetriever cause errors in

XML parser

• AP-21249: Table Reader cannot read large JSON values in Columnar backend

• AP-21246: Report Writer PDF/HTML fails on Hub when used with relative-to workflow

KNIME URL

• AP-21244: REST Client nodes do not properly load proxy settings w/ auth

• AP-21223: Default off-heap memory size strategy often exceeds available RAM when

combined with Xmx

• AP-21089: Application menu bar reads NewApplication instead of KNIME on macOS

Sonoma

• AP-21079: Error when opening OpenAI Connector dialogs with invalid credentials

• AP-21069: K-AI: Build mode fails on smalltalk

• AP-21067: AI Extension nodes pick first matching column during autoconfigure

• AP-21038: Snowflake DB Loader fails in KNIME Executor if local file access is disabled

• AP-20962: Drag and drop extension: Clicking OK in the already installed dialog

duplicates the Hub page

• AP-20930: K-AI doesn’t work with Python extensions

• AP-20904: GPT4ALL Llama 2 outputs garbage

• AP-20841: Python Extension: Adding column filter breaks backwards compatibility

• AP-20721: Sharing Component from within open Component Template throws

NullPointerException

• AP-20451: Node > Update Links Task Does Not Find All Remote Component Updates

• AP-20131: Node identifier in node stats and modern node repo can have clashes

• AP-19876: Partitioning node fails on empty input table

• NXT-2090: Paste doesn’t reliably paste the clipboard content from the previous copy

• NXT-2072: Too many threads comm-pool-thread-1 getting generated (but not

discarded) when generating images in a loop

• NXT-2070: After moving and releasing a node or nodes user interface stays in the

moved state and is not resonsible and usable anymore

• NXT-2036: D&D data files from Hub space to workflows in Modern UI does not add true

path
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• NXT-1995: Double click to open configuration dialog does not work inside linked

metanodes or components for unselected nodes

• NXT-1954: Nodes move by just clicking on them

• UIEXT-1478: Value switch is not keyboard navigatable

• UIEXT-1446: Running multiple Report PDF Writer nodes at the same time breaks the

report

• UIEXT-1327: Remove warnings in reporting for table view

• UIEXT-1322: Prevent editing of dialogs in linked/locked components

• UIEXT-1320: Node descriptions are incomplete: Nested settings are missing

Nodes changing in KNIME Analytics Platform 5.2.0

New Nodes:

• Secret Retriever

• Align to Inertial Principal Axes

• Apply Transforms (RDKit) (Experimental)

• Ertl Scaffold Keys

• Force Field Conformer Energies

• Fragments to MMPs

• Fragments to MMPs (deprecated)

• MMP Calculate Maximum Cuts (RDKit)

• MMP Calculate Maximum Cuts (deprecated)

• MMP Fragmentation Type Loop Start

• MMP Molecule Filter (RDKit)

• MMP Molecule Filter (deprecated)

• MMP Molecule Fragment (3rd Gen) (deprecated)

• MMP Molecule Fragment (RDKit)

• MMP Molecule Fragment (deprecated)

• MMP Molecule Multi-cut Fragment (3rd Gen) (deprecated)

• MMP Molecule Multi-cut Fragment (RDKit)

• MMP Molecule Splitter (RDKit)
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• MMP Molecule Splitter (deprecated)

• MMP Show Cuttable Bonds (RDKit)

• MMP Show Matching Bonds (RDKit)

• Matched Molecular Pairs (RDKit) (deprecated)

• PMI Calculation (deprecated)

• Principal Moment of Intertia (PMI)-Derived PropertiesKNIME HTML/PDF Writer

• Reference Fragments to MMPs

• Marvin JS Widget

• SyGMa Metabolites

• Automated Matched Pairs

• Generic ECharts View

• Image View

• Text View

• String Cleaner

• String Format Manager

• Report Page Break

• Report Template Creator

• Report Loop End

• SARIMA Forecaster (Apply)

• SARIMAX Forecaster (Apply)

• GPT4All Chat Model Connector

• GPT4All Embeddings Connector

• HF Hub Chat Model Connector

• HF TGI Chat Model Connector

• OpenAI DALL-E View

Nodes replaced, old nodes deprecated:

• Box Authenticator

• Microsoft Authenticator

• Google Authenticator

Nodes declared legacy:
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• Table to HTML (Legacy)

• Table to PDF (Legacy)

• JPython Script 1:1 (Legacy)

• JPython Script 2:1 (Legacy)

• JPython Function (Legacy)

• Rule Viewer (local) (Legacy)

• Text Output Widget (legacy)

• Image Output Widget (legacy)

• KNIME Weka Data Mining Integration (3.6) - all nodes in the extension

Nodes renamed:

• Image to Report → Image to Report (BIRT)

• Data to Report → Data to Report (BIRT)

• Report Concatenate (Table) → Report Concatenate (Table) (Labs)

• Report PDF Writer (Labs) → Report PDF Writer

• Report HTML Writer (Labs) → Report HTML Writer

• Report Concatenate (Labs) → Report Concatenate

• Crosstab (legacy) → Crosstab

• Statistics → Statistics View

• HF TextGen LLM Connector → HF TGI LLM Connector

Community Extensions

Partner Extensions

Extension Contributor Changes

KNIME Connector for

SAP(KCS) Nodes

De Villiers Walton Ltd. Available soon

exorbyte extension exorbyte GmbH Available soon

Spotfire File Nodes TIBCO Spotfire Available soon

Trusted Community / Open Source Extensions
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Extension Status

Generic Workflow Nodes for KNIME Available

KNIME Groovy Scripting extension Available

KNIME HCS Tools Available

KNIME Python Scripting extension Available

KNIME R Scripting extension Available

Lhasa Available

OpenMS Available

RDKit Nodes Feature Available

Slack Integration Available

Continental Nodes for KNIME Available

Genentech Available

Geospatial Analytics Extension Available

Neo4J Available

Vernalis KNIME Nodes Available

KNIME Image Processing Available

KNIME-CDK Available

KNIME AI Extension Available

Web Interaction Available

KNIME Nodes for Scikit-Learn (sklearn)

Algorithms

Available

Experimental Open Source Extensions / Experimental Community Extensions

Extension Changes

AF Utility Nodes Available
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Extension Changes

CIR KNIME Integration Available

KNIME Matlab Scripting extension Available

Process Mining Extension Available

Apprise Nodes Available

Erlwood KNIME Open Source Available

KNIME Shapefile Support Available

Indigo KNIME integration Available - Not working on MacOS because

of a bug in Indigo

AI.Associates Signal Processing Available

Enalos Nodes for KNIME Available

PM4KNIME Available

Redfield BERT Nodes Available

Redfield NLP Nodes Available

3D-e-Chem KNIME nodes Available

FSK-Lab Available

Word2Vec Available

PIA Available soon

KNIME Spatial Processing Nodes Available soon

MMI Data Analytics Nodes Not available anymore

OrientDB Not available anymore since 5.1

KNIME Analytics Platform 5.2.1

Release date: February 07, 2024
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Changelog (KNIME Analytics Platform 5.2.1)

Enhancements

• NXT-1906: Basic read-only mode for job viewer

• UIEXT-1518: Generic JavaScript view does not work when sanitisation is activated

• AP-21926: Option to disable authentication check in (Azure) OpenAI Authenticator

• AP-21896: Improve Secret Retriever error message when no KNIME Hub connection is

available

• AP-21790: Mountpoint option in KNIME Hub Authenticator

• AP-21786: Use URLConnection instead of HttpClient for REST requests (improves

stability for concurrent requests)

• AP-21748: Add Legacy/Deprecated labels to the extension names

• AP-21741: Show global customization profiles in AP preferences as well

• AP-21684: KNIME Hub Authenticator with better error and URL validation

• AP-21579: Add configuration option for 'receiveTimeout' in Salesforce Query nodes

• AP-21550: KNIME Hub Authenticator with advanced option to expose URL of current

KNIME Hub as flow variable

• AP-20946: Robustify server address input validation in `AdditionalInformationPanel`s

• NXT-2266: Display full space item name in title

Bug Fixes

• AP-21958: Using local update archive is not possible (kudos to @arushib30 for

reporting 1)

• AP-21851: K-AI doesn’t use proxy for websocket connections

• AP-21784: Vector Store to Tool node dialog fails to load

• AP-21745: Resetting Workflow on KNIME Server not possible

• AP-21738: Missing Plotly extension leads to workflow/component error on load with

deleted node

• AP-21732: Google Authenticator (API Key) (deprecated) fails to load the API key from

knime:// URLs which point to a remote repository

• UIEXT-1493: JavaScript Views do not work with bundled chromium anymore (kudos to

@USCHUKN1ME for reporting 1)
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• AP-21891: OpenAI Connectors fail to list models for non OpenAI API base URLs

• AP-21785: KNIME-wide proxy exclude list dominates REST client nodes

• AP-21777: Email Reader might run indefinitely if a message gets deleted during

processing

• AP-21759: HTTP connections to URLs ignore proxy exclude list

• AP-21736: GPT4All Embeddings Connector node fails to read local models when offline

• AP-21735: Missing node message duplicated for each missing node

• AP-21725: Agent Prompter fails if tool description or tool name is in an invalid format

for OpenAI Functions Agent

• AP-21718: Include Conda Packages of Bundled Python Environment by default

• AP-21707: Space Connector should only warn during configure phase if mountpoint is

unconnected

• AP-21702: Report port deserialization may not respect original fragment order (kudos

to @njconnolly for reporting 1)

• AP-21681: Node repository is empty after installing certain extensions (kudos to

@ralf42 and @danielesser for reporting 1 and 2)

• AP-21658: K-AI doesn’t update disclaimer when switching hub

• AP-21650: Duplicate Row Filter: "Column name of row status" field should disappear

when removing duplicate rows

• AP-21622: Race condition when shutting down draining executor

• AP-21617: Execessive thread creation when loading many jobs

• AP-21540: Email Reader node flags read emails as unread if the "Mark read emails as

read" option is disabled

• AP-21471: DataType.getCommonSuperType() returns type of pm4knime

• AP-21237: macOS Sonoma: Splash screen is displayed upside down (kudos to @ssq

for reporting 1)

• AP-20516: "Model Reader" (and other readers) may leave temp files behind after use

(only for large, complex models such as XGBoost)

• AP-20299: Duration in Table View (classic & modern) sorted like strings

• AP-18133: Excel Reader does not correctly load sheet selection mode (kudos to @Geo

for reporting 1)

• NXT-2316: Workflow SVG is empty if workflow is saved from within component

• NXT-2289: Replacing nodes deletes all bendpoints and undo won’t recreate them
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• NXT-2260: Changes in annotations are lost if a users switch the tab and styles are lost

if you switch from one to another workflow annotation

• NXT-2240: Description in space explorer card overlaps the space card boundaries

(kudos to @mlauber71 for reporting 1)

• NXT-2211: "Save As" workflow not working properly (kudos to @sw1336 for reporting

1)

• NXT-2123: Clicking/tapping really fast on a node can cause an issue (kudos to @takbb

for reporting 1)

• NXT-1939: If Statistics view/computation is aborted, data in Table is no longer shown

(kudos to @DiaAzul for reporting 1)

• UIEXT-1517: Table Editor (JavaScript) reverts to first option on dropdown opening

(kudos to @CHKnime for reporting 1)

Known issue

Network proxy authentication information is cached even after changing username and

password in the KNIME preferences. Restart the application in order to apply the new

authentication (limitation in Java, see Bug Entry).

KNIME Analytics Platform 5.2.2

Release date: March 13, 2024

Changelog (KNIME Analytics Platform 5.2.2)

Enhancements

• AP-22107: Microsoft Authenticator: Allow to set User-Agent

• AP-22016: Add Local prefix to GPT4All LLM and Chat Model Connectors

• AP-21886: Enable HTML sanitization for older JavaScript views by default on executors

• AP-20615: Increase Custom/KNIME URL default timeout to prevent timeout during

redirects

• NXT-2448: Add "workflow configuration" to workflow description

• NXT-2441: Update to Equo Chromium 106.0.25

• NXT-953: Change target of links e.g. in node description, workflow and component
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meta information to be target="_blank"

Bug Fixes

• AP-21872: Reset All button doesn’t function properly for metanodes (kudos to

@Christopher41 for reporting 1)

• AP-21960: Excel Reader: data shifts to wrong columns if re-evaluate formulas option is

not checked (kudos to @Appear3044 and @cinthy for reporting 1 and 2)

• AP-21995: (Image) Download from Generic ECharts View not possible (kudos to

@JeanDavid for reporting 1)

• AP-22019: Can’t set execution retries when initially creating a schedule

• AP-22015: Credentials Configuration and Widget nodes no longer allow overriding

credentials with String variables

• AP-22004: DB Loader fails for Snowflake if the KNIME workspace is located on a

shared drive on Windows

• AP-21997: Integrated deployment: workflow manager instance doesn’t retain custom

workflow name

• AP-21982: Python views do not synchronize with selection 5.1 and 5.2

• AP-21967: Authenticated proxy credentials are saved and reused KNIME-wide till restart

after the first use

• AP-22094: Possible workflow load problem in "Microsoft Authenticator" when port is

connected to component output

• AP-22052: Redundant proxy authentication popups on AP startup

• AP-22022: K-AI Unknown host error

• AP-21992: org.knime.core.table.virtual.graph.cap.Branches: there is no predecessor

branch

• AP-21938: Opening WFs using uninstalled Python Extensions will completely lose the

nodes instead of showing "Missing Node"

• AP-21727: Error messages of failed Python Extension Installations are unusable

• AP-21225: CVE-2023-5562 - JS code injection vulnerability in old JS views (e.g. Table

View)

• AP-21060: Zip Archive Connector fails to open .knwf files

• AP-19239: Multi-file table reader nodes should fail when file schema has changed

• NXT-2419: Hidden metanodes aren’t hidden in the modern UI
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• UIEXT-1620: File Upload Widget finishes too early

HTML sanitization of JavaScript View nodes and Widget nodes

With the release of 5.2.2 KNIME executors will have HTML sanitization of old JavaScript View

nodes and Widget nodes turned on by default. This should ensure that no malicious HTML

can be output. It is still possible to achieve the old behaviour by turning the sanitization off

globally both for KNIME Hub execution contexts (see intstructions here) and for KNIME

Server (see instructions here). For KNIME Server sanitization rules can also be further

customized, see KNIME WebPortal Administration Guide.

Interesting nodes to know about:

• Text Output Widget (legacy): If this is set to output HTML content, it will be sanitized.

You can use the new Text View or Image View which have their own sanitization rules

internally, but allow certain styling tags or exempt the Text Output Widget from

sanitization

• Image Output Widget (legacy): This will not work with sanitization turned on.

Sanitization will strip all SVG tags, leaving in most cases only axis labels and names to

be displayed as plain text. Also the workaround here is to use the new Image View or

add the node to the exemptions.

• Generic JavaScript View: This node is now always exempted from global sanitization

and have an additional flag (-Djs.core.sanitize.sanitizeGenericJSView ) which is

set to true by default for new executors. With this flag enabled all input data to the node

(input table and flow variables) will be sanitized.

This leads to the following behaviour: if a workflow builder set up the node so that just

values are displayed by tables and flow variables it might only loose some formatting or

simply work as before. However if a script was set up in a way that for example HTML

was constructed using the contents of flow variables or JavaScript libraries were

injected using flow variables this will now most likely fail. If this is still needed the

system property has to be set to false explicitly. Additionally there is a new checkbox in

the node to enable/disable this input sanitization. However this will be overwritten if the

system property is set to true.

All other (view) nodes might behave differently if a workflow builder tried to customize styling

by use of HTML (e.g. in table cells or in tooltips used inside of charts). The effects here

should be that either only the styling does not work or some content won’t be visible at all,

depending on the context.
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KNIME Analytics Platform 5.2.3

Release date: March 27, 2024

Changelog (KNIME Analytics Platform 5.2.3)

Enhancements

• NXT-2509: Update to Equo Chromium 106.0.26

Bug Fixes

• NXT-2490: Modern UI doesn’t load in presence of outdated community extension

(kudos to @Ardilla and @arief_rama for reporting 1 and 2)

• AP-22103: Python Views don’t open after unsaved re-execute

• NXT-2480: Dialog crashes AP when being closed and a 'window.alert' window was open

• AP-22229: K-AI doesn’t work with proxy authentication

• NXT-2491: Yellow-Bar Component Projects do not Save Changes Back to Hub/Server in

MUI Hybrid Mode

KNIME Analytics Platform 5.2.4

Release date: May 23, 2024

Changelog (KNIME Analytics Platform 5.2.4)

Bug Fixes

• AP-21776: Joiner might complain about duplicate columns although there are none

(but col names matching '(#1)') (kudos to @weiclav for reporting 1)

• AP-22339: REST nodes fail when using a credentials flow variable for Digest

authentication (kudos to @tescnovonesis for reporting 1)

• UIEXT-1619: The preview of twin list column selection in WebUI dialogs includes wrong

columns (kudos to @mwiegand for reporting 1)

• AP-22412: Python View plot preview does not work (kudos to @JHVines for reporting 1)
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• NXT-2607: MUI load error in case of open temp workflow in a different drive than

workspace’s drive (kudos to @mwiegand for reporting 1)

• AP-22321: Updating nested linked components may fail in executor

• AP-22277: Proxy credentials not supplied for Workflow Jobs with HTTPS Connections

• AP-22368: Generic ECharts View runs forever in reporting in certain report

configurations

• AP-22503: Google BigQuery Connector throws exception with no input connection

• UIEXT-1845: File Chooser Widget does not show files and empty folders

• UIEXT-1795: Modifying displayed statistics settings in Statistics View dialog doesn’t

reset/refresh the preview

• UIEXT-1782: Line plot lines are ignored if not in view port

• UIEXT-1774: Overwriting the whole content of a Text Output Widget with a flow variable

bypasses HTML sanitization

• UIEXT-1751: Wrong data type shown in table view

KNIME Analytics Platform 5.2.5

Release date: June 4, 2024

Changelog (KNIME Analytics Platform 5.2.5)

Bug Fixes

• NXT-2477: Timeout error when generating Report via (Batch) Executor on Windows

(kudos to @Camderman106, @cf_123 for reporting 1, 2)

• UIEXT-1900: View nodes do not work in metanodes if directly connected to inner

metanode output (kudos to @BPU for reporting 1)

• BD-1292: (Big Data Extensions): Fix user impersonation of Big Data Connector nodes

and Create Spark Context (Livy) when running on KNIME Business Hub

• NXT-2640: Job Viewer: Fix message event origin check

KNIME Analytics Platform 5.2.6

Release date: October 16, 2024
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Changelog (KNIME Analytics Platform 5.2.6)

Enhancements

• AP-15669: "Send to Tableau Server" node to support credentials variable (currently

requires user+pass in dialog) (kudos to @KristianRohde for reporting 1)

• AP-23213: Write executor container logs to configurable file

• AP-23160: Respect direct memory setting in Watchdog

• AP-23158: Report KNIME process usage in executor logs

• AP-22969: Extend executor start script to forward executor crash information to stdout

• AP-22951: Allow Conda processes to be terminated by Watchdog

• AP-22950: Allow Python processes to be killed by watchdog

• AP-22948: Add watchdog to AP that kills external processes' that use too much

memory

• AP-22937: Determine executor heap size based on container requests

• AP-22508: Only poll for job updates if team has execution enabled on Hub

• NXT-2748: Update to Equo Chromium 106.0.28

Bug Fixes

• AP-21672: Broken Community Extension might break PortType#availablePortTypes

(should try-catch ExceptionInInitializationError) (kudos to @mwiegand @joel_lewinson

@ajackson for reporting 1 2 3)

• AP-21727: Improve error messages of failed Python extension installations (kudos to

@StevenLauretti for reporting 1)

• AP-22836: Excel Writer dialog shows warning when adding a space to a sheet name but

still executes fine (kudos to @Christopher41 for reporting 1)

• AP-22906: High CPU load when connecting to Hub without execution contexts (kudos

to @mwiegand for reporting 1)

• AP-23134: Switch to modern UI freezes frontend due to uncaught class cast exception

(kudos to @swebb for reporting 1)

• AP-23194: Importing WF from AP <= 5.0 to AP 5.1, 5.2 or 5.3 with a string replacer

causes parameters to not appear (kudos to @tymsk3891 for reporting 1)

• AP-23267: Directories on SMB network share erroneously detected as non-writable

(kudos to @cridiaz for reporting 1)
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• AP-22737: Excel Reader throws IllegalStateException when parsing is cancelled too

quickly (kudos to @locodust6 for reporting 1)

• AP-23008: Installed AP on Windows doesn’t start without installing a JRE if Windows

UTF-8 (locale) was enabled before AP installation (kudos to @ssimara for reporting 1)

• UIEXT-1896: Column renamer sometimes does not rename (kudos to @Tigerfox for

reporting 1)

• AP-22924: Excel Reader dialog can enter inconsistent state when no password is

provided for protected files

• AP-22909: Freeze when trying to open a workflow in Remote Workflow Editor

• UIEXT-2087: Clicking on download link of File Download Widget makes the view black

(node or composite) if the file is a PDF

• AP-23361: Conda Env Propagation node deletes ALL envs if env name flow variable is

blank

• AP-23059: SMB Connector fails with NullPointerException if password in credentials

flow variable is null

• AP-22940: Python doesn’t trust same CA’s as the rest of the AP

• AP-22923: Chroma Vector Store Reader fails with illegal collection name error

• AP-22811: Global proxy settings in executor will break executor functionality

• AP-22752: Topic Extractor (Parallel LDA) node does not show iteration statistics in

certain locales

• AP-22707: Text Embedder fails on table without rows

• AP-22690: Call Workflow Service Node fails calling Service Deployments with "Use

current Hub" Hub Auth Connection

• AP-22617: Hugging Face nodes don’t work for older client version

• AP-22594: Python DateTimeParameter default value has wrong type if

show_time=False

• AP-22558: Fix problem when escaping column placeholder in parameterized and

looping db nodes

• AP-22551: Workflow credential "knime.system.default" is treated by mistake as flow

variable and fails with IllegalFlowVariableNameException

• AP-22498: Conda Env Propagation node fails with latest conda version because --force

flag got removed

• AP-20664: ReadDataCache blocks on close if writing batches failed

• AP-19687: Table Manipulator: Unable To Include Columns On Changing Table Spec
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• AP-19656: String Manipulation logic breaks if KNIME open too long (temp files deleted

by OS)

• AP-10222: Attempted to append to closed appender while logging

• UIEXT-2118: Memory Leak in Table View (ModernUI) keeps reference to workflow

instance

• UIEXT-2054: Image generation in executor (Hub/Server) may crash application under

heavy load (used in data viz nodes w/ image port enabled)

• UIEXT-1966: Two combo boxes on the same interface result in selection issues
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